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1 GENERAL INFORMATION 

1.1 About Programs 
On using Jurasoft Filter Partition and Synthesis Program Pack to design Elliptic filters 

in more advanced way. The program pack consists of two parts: 

Part-I: FILTERPART program 
Part-II: FILTERSYN program 

Both programs will be described in details in this Manual. Programs use the design 
procedures that are documented in [1] in more details. Programs build passive ladder LC 
filters terminated in both ends by resistors that have very low sensitivity to component 
tolerances in the pass-band, according to Orchard’s theorem [2]. In this way obtained ladder 
networks can realize whole or only one part of the standard elliptic filter’s transfer function. 

Those two programs are programmed as a MATLAB’s Graphical User Interface (GUI) 
and should run under the MATLAB environment. Standalone run-time versions of the 
programs are not yet available. It is recommended for users to use MATLAB Version 7 and 
later. It is highly recommended that the resolution of the display is at least 1024x769 pixels. 

1.2 Program Setup 
Using Windows Explorer create the new directory, for example: 

C:\Program Files\MATLAB71\Filterpart10 

or open the existing directory in the MATLAB path, for example: 

C:\Program Files\MATLAB71\work 

Then simply copy all the files from the installation disk into the chosen directory. The file 
names of the files contained on the disk are: 

1.  readme.txt  
2.  usersguidejsfilterpart.doc (this file) 
3.  example4.m 
4.  filterpart.fig  
5.  filterpart.m  
6.  filterpart_help.html  
7.  filtersyn.fig  
8.  filtersyn.m  
9.  filtersyn_help.html  
10. fig1a.jpg  
11. fig1b.jpg  
12. fig1c.jpg  
13. fig1d.jpg  
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Note: If you copy files from CD-Rom it is advisable to turn of the read only attribute. This 
can be done using Windows Explorer. 

To proceed with installation suppose that you have installed (copied) Jurasoft Filter 
Partition and Synthesis Program Pack files into the newly created directory having the name 

C:\Program Files\MATLAB71\Filterpart10 

After starting MATLAB check if yours working directory is the directory, which contains 
copied program files. For example you can type: 

>pwd 

MATLAB notifies you, which is your current working directory. If it is not the directory 
containing your program files, you have two possibilities:  

(i) change to the directory containing above program files. For example you can type: 

>cd ‘C:\Program Files\MATLAB71\Filterpart10’ 

(ii) check to see if your new directory containing above program files is in the MATLAB 
search path. If it is not you can simply add a new directory to the search path by 
typing at the command prompt: 

>path(path, ‘C:\Program Files\MATLAB71\Filterpart10’) 

Now you are able to run programs from any MATLAB working directory. 

Note: If you want to add ‘C:\Program Files\MATLAB71\Filterpart10’ path 
permanently to the MATLAB search path, type: pathtool (pathtool opens the Set Path 
dialog box, a graphical user interface you use to view and modify the MATLAB search path). 
Alternatively, you can select Set Path directly from the File Menu in the MATLAB desktop. 

2 PART-I: ELLIPTIC FILTER PARAMETERS USING FILTERPART 
Adding the Jurasoft FILTERPART program to your tool suite adds a new filter design 

technique of ladder LC filters terminated in both ends by resistors. Use the FILTERPART 
program to develop filters with Elliptic or Cauer-Chebyshev (CC) filter responses that meet 
more complex requirements than those you can design using standard MATLAB functions. 
While the designs using standard MATLAB functions are available as command line 
functions, the graphical user interface (GUI) of Jurasoft FILTERPART makes the design 
process more clear and easier to accomplish. 

2.1 How to start FILTERPART program 
There are two main approaches in using the FILTERPART program: 
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i) “Standard design” of an Nth-order normalized prototype elliptic analog lowpass 
filter: To generate all the zeros (Z), poles (P), and gain (K) of an elliptic filter open JS 
Filterpart enter from the MATLAB command prompt: 

>[Z,P,K] = filterpart 

When FILTERPART program starts user sees a GUI in Fig. 1, which opens in the centre of 
the screen. Upon exit the program returns Z, P and K of the desired transfer function. 

In the program GUI (see Fig. 1) user can easily define: filter order N, Amax (dB) of ripple in 
the pass-band, a stop-band Amin (dB) down, or stop-band edge frequency Fstop (the pass-
band edge frequency Fpass equals to unity). User then pushes “Pole/Zero Calculate” button, 
and simply exits the program. This procedure of calculating P, Z and K resembles using 
standard built-in MATLAB function ELLIPAP, the only difference is in that the user has 
very comfortable way of defining specifications parameters. 

 
Fig. 1 JS FILTERPART program when initially open. 

ii) “Filter Partition” design of an Nth-order normalized prototype elliptic analog low-
pass filter: To obtain partial zeros, and poles, and gain of a lower-than-Nth-order part of an 
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elliptic low-pass filter transfer function, open JS Filterpart from the MATLAB command 
prompt by entering: 

>filterpart 

The GUI as in Fig. 1 starts. By pushing the “Pole/Zero Calculate” button the user first 
calculates all poles and zeros and the gain of the elliptic filter which meets the given 
specifications. After calculation of poles and zeros, those are presented in “Filter Poles” and 
“Filter Zeros” list boxes, and the gain is shown in “Filter Gain K” edit text box. List boxes 
display a list of items and enable users to select one or more items. User then has an 
opportunity to select desired poles and zeros and then push “Normalize K.” Using “Export 
Selected P/Z and K” command from the File Menu, the program exports variables Z, P, and 
K to the MATLAB ‘base’ workspace. If user selected all poles and zeros from theirs List 
boxes by pressing “Select All” push button, the exported Z, P, and K were identical to those 
in approach i) Standard design of an Nth-order normalized prototype elliptic analog LP filter. 

2.2 Defining Filter Specifications Parameters 
In this section various parts and panels of the FILTERPART GUI, which is shown in 

Fig. 1 are described. “Filter Specifications” panel shown in Fig. 2 helps users to understand 
the meaning of edit text boxes inside input data panels. The user can define the filter design 
data in the form of specifications using input data panels named “Frequency Specifications” 
and “Filter Loss Specifications” shown in Fig. 3. 

 
Fig. 2 Filter Specifications panel. 

Edit text boxes (controls) are white rectangles in Fig. 3, containing numbers that the 
users can edit. Note that in “Frequency Specifications” and “Filter Loss Specifications” 
panels’ text labels nearby edit text boxes (controls) correspond to those in “Filter 
Specifications” panel shown in Fig. 2.  

     
Fig. 3 Frequency and Filter Loss Specifications panels. 
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Users define values for the filter design using edit text controls. Once user defines the 
value of some parameter using edit text control, the program converts it to the double 
precision number and uses it with full precision in future calculations. On the other hand, the 
program displays only 5 to 6 decimal places in the display or in the edit text. That means the 
program has rounded the displayed value to 5 to 6 decimal places, but still performs 
calculations in full precision of 15 or more decimal places. Once users write the value into an 
edit text box the program accepts the value when user goes to other edit text box, or when 
presses enter. 

GUI users can use the following available keyboard accelerators to modify the content 
of an edit text and to provide design data to the program: 

• Ctrl+X – Cut 
• Ctrl+C – Copy 
• Ctrl+V – Paste 
• Ctrl+H – Delete last character 
• Ctrl+A – Select all 

2.3 Filter Order 
There are two mutually exclusive options for determining the filter order when you 

design an elliptic filter: i) Specify order—user enters the filter order in a text box. ii) 
Minimum order—the program determines the minimum order of the filter by itself.  

In “Filter Order” panel shown in Fig. 4 user can specify the order N of the filter to 
design, or can instruct the program to calculate minimum order of the filter which satisfies 
given specifications.  

 
Fig. 4 Filter Order panel. 

Note that the order N of the filter is always reported in the title on the top of the 
program as shown in Fig. 5. 

 
Fig. 5 Filter Order report. 

If user checks the “Fstop or Theta instead Amin” checkbox as shown in Fig. 6(a) then 
Fstop frequency specifications parameter can be defined as input parameter [see Fig. 6(b)], 
whereas the value of Amin(dB) parameter can not be entered because it is disabled for the 
input [see Fig. 6(c)]. Comparing to the case in Fig. 1, where “Fstop or Theta instead Amin” 
checkbox is not checked, on the contrary, a user is able to define Amin but not Fstop as the 
starting design parameter (Fstop edit text box is disabled in Fig. 1). 
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(a)                                                    (b)                                                 (c) 

Fig. 6 (a) Filter Order panel’s “Fstop or Theta instead Amin” check box is checked. (b) Influence on the  
“Frequency Specifications” panel; (c) Influence on the “Filter Loss Specifications” panel. 

If the “Minimum Order” radio button is selected, a user can enter all specifications 
values as shown in Fig. 7. Note in Fig. 7(a) that the “Specify Order” edit-text box is disabled 
(dimmed) thus a user cannot input the filer order N. 

     
(a)                                                    (b)                                                 (c) 

Fig. 7 (a) The “Minimum Order” radio button is selected. (b)-(c) All specifications input fields are enabled. 

After pushing “Pole/Zero Calculate” button program calculates the filter order and the 
minimum value of normalized Fstop frequency. The program presents those parameters as 
shown in Fig. 8. Besides, the program presents poles, zeros, and gain of the calculated elliptic 
filter in the appropriate panel. 

     
(a)                                                    (b)                                                 (c) 

Fig. 8 (a) The “Minimum Order” radio button is selected and the “Pole/Zero Calculate” button has been pushed. 
The filter order was calculated and presented (dimmed). (b) Fstop was calculated and presented. (c) Remains the same. 

Recall that the presented values are rounded to 5 decimal places, and that in the 
calculations the program uses more than 15 decimal places. 

2.4 Various Input Data Types 
The program allows the user to input filter design data in various ways. For example if 

user knows only real (denormalized) pass-band and stop-band edge frequencies from filter 
specifications, those can be very simply normalized using the program. The user can simply 
type in denormalized values while the Units Pop-up Menu is in position “rad/s” and then 
chooses ”Normalized” Units. The program then calculates and displays new normalized 
values for Fpass and Fstop frequencies. The program normalizes both Fpass and Fstop to 
Fpass, where the new Fpass frequency equals to unity and the new Fstop equals to 
Fstop/Fpass (without any dimension). 
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(a)                                                    (b) 

Fig. 9 (a) Frequency Specifications panel’s Units Pop-up Menu is in general position “rad/s”. (b) When user chooses 
”Normalized” units, program calculates new normalized values of Fpass (=1) and Fstop. 

The “Input data Type” panel shown in Fig. 10(a) and Fig. 11(a) enables the users to set 
various input data or to recalculate input data from one form to other. The options in the 
panels change to let you set (or see) the values that define your filter. 

If “Rho instead Amax” check box is checked as shown in Fig. 10(a), instead Amax 
(dB) a user is able to enter the reflection factor Rho in percentage as shown in Fig. 10(b). The 
label beside the edit text box is “Rho (%)”. When “Rho instead Amax” check box is 
unchecked the corresponding Amax (dB) value is displayed as shown in Fig. 10(c). The label 
changes to “Amax (dB)”.  

     
(a)                                                    (b)                                                 (c) 

Fig. 10 (a) Input Data Type panel’s “Rho instead Amax” check box is checked. (b) Influence on the  
“Filter Loss Specifications” panel when checked; (c) when not checked. 

The program calculates Amax (dB) from given Rho (%) using: 

 , (1) }(%)]01.0[1log{10)dB( 2
max ρ⋅−−=A

or calculates Rho(%) from known Amax(dB) using: 

 10/)dB(max101100(%) A−−⋅=ρ . (2)  
If “Theta instead Fstop” check box is checked as shown in Fig. 11(a), instead Fstop a 

user is able to enter the Theta in degrees as shown in Fig. 11(b). Note that the Units have 
been automatically set to the “Normalized”. The label beside the edit text box is “Theta 
(deg)”. When “Theta instead Fstop” check box is unchecked the corresponding Fstop value is 
displayed as shown in Fig. 11(c). The label changes to “Fstop”.  

     
(a)                                                    (b)                                                 (c) 

Fig. 11 (a) Input Data Type panel’s “Theta instead Fstop” check box is checked. (b) Influence on the  
“Frequency Specifications” panel when checked; (c) when not checked. 
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The program calculates Fstop from given Theta(°) using: 

 
)(sin

1
°Θ

=stopF , (3) 

or calculates Theta(°) from known Fstop using: 

 





=°Θ

stopF
1arcsin)( . (4) 

Recall that the presented values are rounded to 5 decimal places, and that in the 
calculations the program uses more than 15 decimal places. 

2.5  “Pole/Zero Calculate” Button and Pole/Zero Selection 
When all design data in specifications are defined pushing “Pole/Zero Calculate” 

button calculates corresponding poles, zeros and gain values of the elliptic filter and fill them 
into “Filter Data” panel’s list boxes on the right side of the GUI. Note that the Filterpart 
program shows strings “<empty>” before the poles and zeros are calculated. 

The user has an opportunity to select desired poles and zeros in theirs list boxes simply 
by a mouse click, or can select them all by pushing “Select All” push button below. How 
users can select poles and zeros is the question how users select multiple items in a list box. 
List box multiple selection follows the standard for most systems: 

• Control-click left mouse button — noncontiguous multi-item selection 
• Shift-click left mouse button — contiguous multi-item selection 
• Click left mouse button on one item inside one list box, release the button, and then 

Control-A— selects all items (or user can press “Select All” push button below). 

Users must use one of these techniques to select desired poles and zeros. 

Once a user selected desired poles and zeros there are many possible ways to proceed 
to the next step. In the next step user can: 

i) draw magnitude in dB of the transfer function that corresponds to the selected poles 
and zeros, 

ii) draw the pole-zero plot that corresponds to the selected poles and zeros, 
iii) using the File Menu command “Export Selected P/Z and K”, export the poles and 

zeros to the MATLAB ‘base’ workspace for the subsequent synthesis of the filter 
network, 

iv) instead exporting selected P, Z and K user can proceed to the filter synthesis with 
those selected P, Z, and K, simply by pushing “Filter Synthesis>>” button below. 

More on filter synthesis is described below in the “Part II: Filter Elements Synthesis 
Using FILTERSYN”. 
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2.6 Menu Commands 
Beside push buttons such as “Pole/Zero Calculate” and “Filter Synthesis”, user can use 

Tools Menu commands to start the same actions. 

User can use the View Menu commands to present the magnitude of the transfer 
function that corresponds to the selected poles and zeros, pole-zero plot of selected poles and 
zeros or can select to see the general filter specifications. Besides, a user has an opportunity 
to use a Context Menu, by clicking the right mouse button over the axis area, which offers the 
same commands as the View Menu. (The axis area is the area of the GUI figure where filter 
specifications, magnitude or pole-zero plots are presented.) 

If user wants to see filter magnitude in the more details user has an opportunity to use 
the View Menu’s “Zoom Window” as shown in Fig. 12. Zoom Window can be used to 
change X and/or Y Axis Min and/or Max values of the current axis. This zooming window 
can be applied to scale the filter pole-zero diagram, as well. 

 
Fig. 12 Zoom Window. 

When choosing to draw the magnitude of the transfer function that corresponds to the 
selected poles and zeros the FILTERSYN program checks if the user has correctly selected 
poles and zeros in complex-conjugate pairs. If not, the program takes no actions but warns 
the user with the following warning box, as shown in Fig. 13. 

 
Fig. 13 Warning dialog box: select complex numbers in conjugate pairs. 

After pushing an “Ok” button user has an opportunity to more carefully select poles 
and zeros once again. For the pole-zero plot the program does not check if poles and zeros are 
selected in complex-conjugate pairs. 

Using Help Menu item “Jurasoft Filterpart Help” user can obtain help in html format. 
Using “About Jurasoft Filterpart” the About dialog box appears providing to the user with the 
most important data about the program and about the author. The About dialog box is 
displayed in Fig. 14. 
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Fig. 14 About Jurasoft Filterpart dialog box 

On the File Menu user can choose “Print” to print the whole GUI figure (the whole 
program window as user can see) Finally, there exist “Exit” command to exit the program. 

2.7 Exiting the Program 
When user wants to exit the FILTERPART program by selecting File Menu “Exit” 

command the program displays the dialog box as shown in Fig. 15. 

 
Fig. 15 Exit dialog box 

In the dialog box user has an opportunity not to exit from the program by choosing 
“No” answer. This prevents user from accidentally closing the program and loosing design 
data. Furthermore, the program checks if the other application FILTERSYN is open, as well, 
and if it is, closes both applications. 

2.8 Launching Synthesis 
When user selects desired poles and zeros for the synthesis user can draw the pole-zero 

plot as a first check. Besides user can draw the magnitude of the transfer function to check if 
it has a maximum gain of 0dB. To correct the magnitude gain when its maximum value is 
other than 0dB, user has to recalculate the gain K by pressing “Normalize K” button. Now 
everything is ready to start the synthesis procedure.  

To start the synthesis procedure user has the following two opportunities: 

i) use “Export Selected P/Z and K” from the File Menu to export selected poles, zeros 
and gain. The program names the workspace variables by Z, P, and K. User can later start the 
program FILTERSYN from command prompt by entering: 

>filtersyn(Z,P,K) 
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ii) simply press “Filter Synthesis >>” button to start the synthesis procedure. 

When pushing “Filter Synthesis >>” button to start the synthesis procedure, the 
synthesis is started with the selected poles and zeros. Then the FILTERSYN, program checks 
if the user has correctly selected poles and zeros in complex-conjugate pairs. If not, the 
program takes no actions but warns the user with the warning dialog box as in Fig. 13: 
“Please select conjugate complex pairs!”. After pushing an “Ok” button, user has an 
opportunity to more carefully select poles and zeros once again. 

2.9 Comparison of FILTERPART to standard functions for elliptic-filter design 
In MATLAB there exist two standard functions ELLIPORD and ELLIPAP for elliptic 

filter design. In this section the comparison of those two functions to the program 
FILTERPART is presented. The function ELLIPORD—Elliptic filter order selection is run 
from the MATLAB command prompt by entering: 

>[N, Wn] = ellipord(Fpass, Fstop, Amax, Amin, ‘s’) 

and returns the order N of the lowest order analog elliptic filter that loses no more than Amax 
(dB) in the passband and has at least Amin (dB) of attenuation in the stopband. Fpass and 
Fstop are the passband and stopband edge frequencies, in radians/second. ELLIPORD also 
returns Wn, the elliptic natural frequency to use with ELLIPAP to achieve the specifications.  

The function ELLIPAP—Elliptic analog low-pass filter prototype is run from the 
MATLAB command prompt by entering: 

>[Z,P,K] = ellipap(N,Amax,Amin) 

and returns the zeros, poles, and gain of an N-th order normalized prototype elliptic analog 
lowpass filter with Amax (dB) of ripple in the passband and a stopband Amin (dB) down. 

FILTERPART program is better than above two standard MATLAB functions because: 

• FILTERPART comprises functionality of both ELLIPORD and ELLIPAP, 
therefore only FILTERPART function can be used. The FILTERPART is 
programmed as GUI and therefore is user-friendlier than those two standard 
MATLAB functions. 

• Instead of MATLAB standard ELLIPAP function, FILTERPART uses two ultra 
high-speed built in functions for calculating elliptic filters transfer functions using 
Landens’ transformations presented by H. J. Orchard in [3]; 

• When in “Minimum filter Order” mode, FILTERPART first uses ELLIPORD to 
calculate minimum filter order, and then calculates Z, P, and K using ELLIPAP. In 
addition FILTERPART calculates and presents new Fstop value as in Fig. 8(b); 

• When in mode “Specify Order” FILTERPART uses two built in Orchard’s 
ELLIPAP functions to calculate Z, P, and K. In addition FILTERPART has two 
input possibilities: (N, Amax, Amin) and (N, Amax, Fstop). FILTERPART 
calculates and presents the remaining fourth parameter Fstop and Amin for the two 
possibilities, respectively; 
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• FILTERPART can input specifications data in various forms: e.g. Theta(°) instead 
Fstop and Rho(%) instead Amax(dB). It can convert one input data to other; 

• FILTERPART provides the ability for the user to simply select desired poles and 
zeros, and present them graphically, as well as the corresponding transfer function 
magnitude. Finally it can calculate the new gain K value to obtain maximum of the 
magnitude at 0dB; 

• FILTERPART can simply export poles, zeros and gain K to the MATLAB ‘base’ 
workspace, or it can immediately call the filter synthesis program FILTERSYN. 

Because of many advantages program FILTERPART can regularly be used in 
MATLAB where it can fully replace ELLIPORD and ELLIPAP when designing analog 
lowpass prototype filters of elliptic type. With FILTERPART the user does not need any 
filter tables any more (e.g. Zverev [4]), or any other design programs (e.g. MICROSIM Filter 
design program) to generate poles and zeros of elliptic filters. Everything you need is in 
FILTERPART. 

Note: The even Nth-order elliptic filter generated by MATLAB function ELLIPAP (and 
FILTERPART) has N/2 transfer function zeros, whereas the one tabulated in Zverev [4] has 
N/2-1 zeros. For example, 6th-order CC filter transfer function in Zverev has only 2 transfer 
function zeros, whereas the filter obtained in MATLAB, has even 3 zeros. There exist no 
such difference for the odd-order transfer functions. 

2.10 Examples 
Example 1: “Standard Filter Design” generating all pole and zero values for the elliptic 
filters.  

In this example we shall calculate all parameters of the standard filter CC 5 25 49. 
Because we know the filter order N=5 we select the “Specify Order” radio button for this 
example. Furthermore, to enable the input of the proper starting values we also have to check 
“Fstop or Theta instead Amax”, “Rho instead Amax” and “Theta instead Fstop” check boxes. 
Now we can enter the values corresponding to CC 5 25 49 as shown in Fig. 16(a). If we want 
to see the corresponding Fstop and Amax(dB) values we can simply uncheck the “Rho 
instead Amax” and “Theta instead Fstop” check boxes as shown in Fig. 16(b) and read the 
values. 

After pushing “Pole/Zero Calculate” button program calculates the value for Amin (dB) 
(dimmed) [see Fig. 16(b)] and fills in poles, zeros and gain K in “Filter Data” panel as shown 
in Fig. 16(c).  

Once the poles and zeros of the standard elliptic CC 5 25 49 filter are calculated user 
can push “Select All” button to select all poles and zeros [see Fig. 17(c)] and then see the 
corresponding magnitude as in Fig. 17(a), or the corresponding pole-zero plot as in Fig. 
17(b). Note that in this case no normalization of gain K is needed because the magnitude has 
its maximum at 0dB. This can be verified by zooming the magnitude characteristic. 
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(a) 

 
(b) 

 
(c) 

Fig. 16 (a) Example of calculating CC 5 25 49 filter. (b) User can simply read the corresponding 
Fstop and Amax (dB) values. After pushing “Pole/Zero Calculate” button program calculates 

the value for Amin (dB) (dimmed) and (c) program presents poles, zeros and gain. 

 

(a) 

 
(b) 

 

(c) 

Fig. 17 (a) Magnitude of the CC 5 25 49 filter. (b) Pole zero diagram. (c) All poles and zeros selected. 



 14 FILTERPART AND FILTERSYN 

Example 2: “Filter Partition Design” generating (some) partial pole and zero values (selected 
by user) for the (N-2)nd–order part of the elliptic filters transfer function. 

In this example we shall first calculate the parameters of the standard filter CC 5 25 49 
in the same way as in the Example 1 above. Once the poles and zeros are calculated user can 
select desired poles and zeros as in Fig. 18(c) and then see the corresponding magnitude as in 
Fig. 18(a), or the corresponding pole-zero plot as in Fig. 18(b) of the part of the standard CC 
5 25 49 filter. Note that in this case the normalization of the gain K is needed because the 
magnitude in Fig. 18(a) has its maximum less than 0dB. 

 
(a) 

 
(b) 

 
(c) 

Fig. 18 (a) Magnitude of the part of the CC 5 25 49 filter. 
(b) Partial pole-zero diagram. (c) Some poles and zeros selected. 

 
 
 

 
(a) 

 
(b) 

Fig. 19 (a) By pressing Normalize K the new filter Gain K value is calculated and presented. 
(b) When redrawing Filter Magnitude the maximum magnitude is 0dB. 
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User press “Normalize K” button and the new filter gain K is calculated (in double 
precision) and only 6 decimal places are shown as in Fig. 19(a). User has to initiate the 
plotting of the filters magnitude from the View Menu again and then the new magnitude as in 
Fig. 19(b) is redrawn showing that the maximum magnitude is now at 0dB. 

In general, user can select any combination of poles and zeros. To be sure which 
combination was selected the user can first look at the pole zero diagram, because it presents 
only those that have been selected. After it user can check to see the magnitude 
corresponding to the selected poles, zeros and gain. Finally, when the gain K is normalized, 
user can again look at the magnitude (maximum). 

Once the poles and zeros are selected and the optimum gain K calculated, using File 
Menu command “Export Selected P/Z and K”, the P, Z and K arrays could be exported to the 
MATLAB’s ‘base’ workspace. The program notifies that there are new variables by 
displaying them in the Command window as in Fig. 20. 

 
Fig. 20 MATLAB command window. The variables Z, P and K are exported to the ‘base’ workspace 

by pressing File Menu command “Export Selected P/Z and K”. 

To check that those variables exist in the MATLAB workspace user can start the 
command “who” in the Command window after leaving the FILTERPART. The answer on 
the command “who” shows all variables in workspace as in Fig. 21. 

 
Fig. 21 MATLAB command window. The variables Z, P and K exist in the ‘base’ workspace. 

In the Part-II we proceed with filter synthesis. 
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3 PART II: FILTER ELEMENTS SYNTHESIS USING FILTERSYN 
Adding the Jurasoft FILTERSYN program to your tool suite adds an Elliptic or Cauer-

Chebyshev (CC) filters synthesis technique of ladder LC networks terminated in both ends by 
resistors. Whereas the FILTERPART has its counterparts in standard MATLAB functions 
such as ELLIPORD and ELLIPAP, the MATLAB in contrast does not posses any built-in 
synthesis program similar to FILTERSYN. Although, there exist many commercial programs 
for the filter synthesis (FILSYN, MICROSIM, etc.), none of them allow users to design a 
network from only a part of the transfer function, i.e. to design filters by “Filter Partition” as 
can be done using FILTERSYN.  

The FILTERSYN program is capable of realizing only certain types of the networks 
(that realize elliptic filters, as networks in Zverev [4]). In the future it will be expanded to be 
able to design other standard networks. At the moment the FILTERSYN is the only existing 
synthesis program in the MATLAB.  

3.1 How to start FILTERSYN program 
To start the FILTERSYN program user has three possibilities: 

i) Using FILTERPART with selected poles and zeros by pushing “Filter Synthesis>>” 
button (see section “Launching Synthesis” above), 

ii) Use FILTERPART to export poles and zeros to the MATLAB workspace. Then 
type from the MATLAB command prompt (see section “Launching Synthesis” 
above): 

>filtersyn(Z,P,K) 

iii) Using poles and zeros from filter tables (e.g. Zverev). When there are no poles and 
zeros in the MATLAB workspace generated by any MATLAB program and user 
posses some other source of pole and zero values such as filter tables, user should 
write a script containing those pole and zero values and call a FILTERSYN 
program using that script. In that case FILTERPART program is not used. An 
example of such script is file “example4.m” (see more about scripts in MATLAB). 

When FILTERSYN program starts user sees a GUI as in Fig. 22, which opens on top of the 
FILTERPART program slightly shifted to the right and to the top, off the screen centre. 

There are two main approaches in using the FILTERSYN program: 

i) “Standard design” of an Nth-order normalized prototype elliptic analog low-pass 
filter: To generate the network, user has to select all the zeros and poles of an 
elliptic filter to start the synthesis using FILTERSYN. 

ii) “Filter Partition” design of an Nth-order normalized prototype elliptic analog low-
pass filter: To generate the network user has to select partial zeros and poles, and 
recalculate the gain K of a lower-than-Nth-order part of an elliptic low-pass filter to 
start the synthesis using FILTERSYN. 

Those two approaches slightly differ in some design steps. 
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Fig. 22 JS FILTERSYN program when initially open. 

3.2 Description of the FILTERSYN program GUI 
In what follows various parts and panels of the FILTERSYN GUI, which is shown in 

Fig. 22 are described. 

 
Fig. 23 Filter Schematics panel with initial network. 
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“Filter Schematics” panel shown in Fig. 23 presents the current filter network under 
synthesis. At the time of synthesis from View menu user can choose a schematic, and use it 
as help. User can choose among four schematics that are shown in Fig. 24. 

(a) (b) 

(c) (d) 
Fig. 24 Possible filter networks. (a) Odd-order filter. (b) Even-order filter. 

(c) Odd-order dual filter. (b) Even-order dual filter. 

The FILTERPART program calculates only elements of the filter networks as shown in 
Fig. 24(a) and (b). If user wants to calculate elements of the dual circuits in Fig. 24(c) and 
(d), those have the same values as elements in the original networks at the same position but 
of the dual character. Thus, at the position 1, instead of shunt capacitor C1 in the original 
network in Fig. 24(a), there exists series inductor L1 in the dual network in Fig. 24(c), both 
having the same value. At the position 2, instead of C2 in the original network, there exists L2 
in the dual network with the same values; L2 in original has the same value as C2 in dual 
network, and so on. There is only one difference in that the user has to calculate the value for 
R2 in dual network as the reciprocal value of R2 given in the original network. The same 
tabulation principle of element values is used in the most filter tables (e.g. Zverev [4]). 
Furthermore, at all schematics in Fig. 24 input and successive impedances Zi or admittances 
Yi are shown for the user to follow the synthesis procedure more easy. 

At the time of initialisation, when the FILTERPART program starts, it calculates the 
square magnitude of the reflection coefficient Rho, i.e. ρ(jω)2, from filter design data such 
as: filter poles P, zeros Z, and gain K. Recall that Z, P, and K are the input design data for the 
program. The reflection coefficient zeros are calculated at the time of initialisation, as well. 
Those are presented in the “Filter Synthesis Data” panel’s List-box labelled “Reflection 
Zeros” as shown in Fig. 26(a). All together there are 2N zeros that are presented, and they are 
indeed zeros of the square magnitude of the reflection coefficient Rho ρ(jω)2.  

3.3 Menu Commands 
User can use the View Menu commands to present the network schematics to be 

realized, the magnitude of the transfer function that corresponds to all poles and zeros in the 
synthesis, square magnitude of the reflection coefficient Rho, or the reflection coefficient 
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zeros. If user wants to see filter magnitude, Rho square magnitude or Rho zeros diagram in 
more details user can start from the View Menu the “Zoom Window” as shown in Fig. 12 
above. 

Using the View menu user can choose to see the magnitude of the transfer function to 
be synthesized, as shown in Fig. 26(b). The user can simply check if the magnitude maximum 
is at 0dB. The procedure of the gain K normalization is available in the program 
FILTERSYN, to obtain the maximum of the magnitude to be at 0dB. When user press 
“Normalize K” button, the new values of reflection zeros are recalculated and presented. 
Furthermore, using the “Rho Square” command from the View menu user can choose to see 
the square magnitude of the reflection coefficient Rho, i.e. ρ(jω)2, as shown in Fig. 26(c). 
It can provide the user with preliminary information about filters magnitude sensitivity to 
component tolerances in the pass-band.  

On the File Menu user can choose “Export Elements” to export the calculated element 
values at any step of the synthesis into the MATLAB workspace, “Print” to print the whole 
GUI figure (the whole program window as user can see) and “Close” to exit the FILTERSYN 
program. 

Using Help Menu item “Jurasoft Filtersyn Help” user can obtain this document in html 
or using “About Jurasoft Filtersyn” the About dialog box appears providing to the user with 
the most important data about the program and about the author. The About dialog box is 
displayed in Fig. 25. 

 
Fig. 25 About Jurasoft Filtersyn dialog box. 

3.4 “Standard design” of a CC 5 25 49 filter 
We proceed with synthesis of a CC 5 25 49 filter, i.e. with the same example which we 

described in FILTERPART program. In this example we design a filter network using 
“standard design”, i.e. we calculate all network elements and those are elements of ladder LC 
network terminated in resistances in both ends. All poles and zeros of the transfer function 
are selected before the synthesis started and the obtained network should be of the 5th order. 
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Besides the synthesis example of CC 5 25 49 filter, in this section we continue with the 
description of the FILTERSYN program GUI. 

 
(b) 

 
(a) 

 
(c) 

Fig. 26 (a) Zeros of the Reflection Coefficient Rho. (b) Magnitude of the CC 5 25 49 filter. 
(c) Square Magnitude of the Reflection Coefficient Rho. 

In what follows the reflection coefficient Rho is denoted by ρ(s), whereas its numerator 
is denoted by F(s). The user has an opportunity to choose zeros of ρ(s), i.e. “Reflection 
Zeros” [those are zeros of F(s), as well] from the “multiple selection” List-box in Fig. 26(a). 
Reflection zeros should be chosen according to the following rules: because F(s) does not 
need to be Hurwitz polynomial we are not constrained that all reflection zeros are in the left-
half plane. The complex zeros of the ρ(jω)2 appear in quadruplets, thus the only 
requirement is that if we choose one complex root, we have to choose its conjugate to obtain 
real coefficients of F(s). The real zeros of ρ(jω)2 appear only in pairs, e.g. if σ1 is a zero 
then –σ1 is zero, as well. Since only squared magnitude of reflection coefficient is given, the 
zero distribution of F(s) is optional, as long as F(s)⋅F(–s) (and s=jω) represents the numerator 
of ρ(jω)2. Thus F(s) with all its zeros in the left-half plane is an acceptable zero 
distribution, the other can be obtained from this one by replacing any real-zero factor or pair 
of complex conjugate zeros by its mirror image, or a combination of such substitutions can be 
made. Recall that there are 2N zeros, and that we choose N of them.  

In Fig. 26(a) a “single selection” List-box situated on bottom of the panel containing 
transfer function zeros at finite frequencies is presented. The program performs the network 
synthesis by full removal of poles at frequencies of those zeros in the order they are presented 
in “Choose Zeros Order” List-box. To every full pole removal at one finite frequency 
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corresponds one parallel RC circuit in the network. User can choose another order of zeros by 
simply choosing a single zero in the List-box and shifting it up or down. This task is usually 
required when the synthesis procedure yields negative component values. 

User has an opportunity to call “Rho zeros” command from the View menu, and the 
program draws in the s-plane, zeros selected in the “Reflection zeros” List-box. In this way 
user can see optically what zeros he selected. Note that Rho zeros in Fig. 26(a) have real parts 
that are very small, they are of the order 1e-8, so user can check on the “Truncate Real Parts” 
checkbox. The obtained zeros are then purely imaginary as shown in Fig. 27(a), and the 
corresponding zeros plot in the s-plane is in Fig. 27(b). 

 
(a) 

 
(b) 

Fig. 27 (a) Zeros of the Reflection Coefficient Rho without real part. (b) Reflection Coefficient Zeros plot. 

When selected zeros, user can proceed to the synthesis (recall that user has to select N 
zeros and if they are complex they should be in complex conjugate pairs). The first synthesis 
step is calculating the reactance to be synthesized. User can choose among X1O, X1S, X2O 
or X2S from the “Choose Immitance Function” panel’s radio buttons as shown in Fig. 28. 
The X1 refers to the input reactance at the port 1, while the other port 2 is in open circuit (in 
the case “O”), or is in short circuit (in the case “S”). The X2 selection refers to the reactance 
at the port 2, etc. Next, user has to press “Calculate Immitance” button, and the immitance is 
calculated and shown in “Immitance” panel as in Fig. 31(d). 

 
Fig. 28 Choose Immitance to calculate. 

If user failed to correctly choose reflection coefficient zeros, for example if lower 
number of zeros has been chosen than the order of the filter N, or user accidentally failed to 
choose zeros in complex conjugate pairs, the program notifies those erroneous cases by the 
error messages as shown in Fig. 29, and the immitance is not calculated. After pushing an 
“Ok” button user has an opportunity to more carefully select Rho zeros once again. For the 
Rho zeros plot, the program does not check the number of zeros or if they are selected in 
complex-conjugate pairs 
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Fig. 29 Error messages when user failed to select the reflection zeros in proper way. 

The message panel “Synthesis Process” shown in Fig. 30 notifies the user about the 
next step to be undertaken. In Fig. 30(a) the message presents a beginning and in Fig. 30(b) 
an end of the synthesis process. Some messages of internal steps of the synthesis process are 
presented in Fig. 31(a)-(c). 

(a) (b) 

Fig. 30 Message panel “Synthesis Process”. (a) At the beginning and (b) At the end of the synthesis. 

(a) (d) 

(b) (e) 

(c) (f) 
Fig. 31 (a)-(c) Message panel. (d)-(f) The calculated immitance is presented in “Immitance” panel. 

The message panel in Fig. 31(a) instructs the user to first check the immitance shown in 
“Immitance panel” in Fig. 31(d) to see if it should be inverted. If the order of the polynomial 
in the numerator is lower than the order of the polynomial in the denominator user has to 
switch on the toggle button “Invert Immitance” and then proceed. When the user press “Go 
To The Next Step” push button and if the toggle button “Invert Immitance” is switched on, 
the new inverted reactance, i.e. susceptance is shown in “Immitance panel” as in Fig. 31(e). 
This is the susceptance Y1 to be realized and the user can proceed. In the remaining figures 
the subsequent steps are presented. The message panel in Fig. 31(b) shows that the next 
operation on addmitance Y1 will be partial pole removal at infinity, and as soon as this 
operation has been completed, new remaining reactance Z2 is shown Fig. 31(f), etc. The 
presentation of the transfer function of the remaining immitance to be realized, helps user to 
keep track of the overall synthesis procedure. User can quickly see if all coefficients in the 
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immitances have positive and real coefficients. If not, something went wrong and probably 
some other order of the zeros in “Choose Zeros Order” List-box in Fig. 26(a) should be 
arranged. After each step the calculated elements are shown in the element vales are 
presented in the “Filter Elements” panel as in Fig. 32(a). User can quickly see if element 
values are positive and real. If not, something went wrong and probably some other zeros 
order could fix the problem, as well. 

Note that the highest order in the numerator in Y1 is 5 and that it is the same as the 
network order. In some cases it can happen that the highest order is lower than the network 
order, and then the user has to calculate other more suitable immitance to be realized, e.g. 
X1S, X2O or X2S. 

Once the all elements are calculated they are presented in the “Filter Elements” panel 
rounded to 6 decimal places as in Fig. 32(a). If user wants, those could be exported to the 
MATLAB’s ‘base’ workspace using File Menu command “Export Elements”. The program 
notifies that there are new variables by displaying them as in Fig. 32(b). To check that those 
variables exist in the MATLAB workspace user can start the command “who”, which shows 
all variables in workspace as in Fig. 32(b). Note that, if the “format long” command has been 
executed before, the elements in the command window are presented in 14 decimal places. 
Recall that, regardless of displaying only few decimal places, the program always performs 
calculations in double precision. 

 
(a) 

 
(b) 

Fig. 32 Filter elements. (b) MATLAB command window after pressing File Menu command “Export Elements”. 
The filter elements are exported and exist in the ‘base’ workspace as variables. 

By presenting element values we conclude this example of network synthesis. Filter networks 
that realize calculated filters are shown in Fig. 34. If we compare the calculated values to the 
element values of the same circuit in some commercial filter tables we can conclude if our 
synthesis program has designed the same circuit. For example, in Zverev on pages 220-221 
there are tables with pole-zeros values and filter elements of the CC 5 25 49 filter. The tables 
are repeated here in Fig. 33. Comparing our elements with those in tables we see that our 
synthesis program works correctly, because we have obtained the same elements. 
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(a) 
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(b) 

Fig. 33 Tables in Zverev: CC 5 25 49 filter. 
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Fig. 34 (a) Doubly terminated LC-ladder realization of CC 5 25 49 filter 

that was originally calculated using FILTERSYN. (b) Dual network. 

3.5 “Standard design” of a CC 6 25 50 filter 
In this example we present standard design of the filter network when we start with all 

poles and zeros values from filter table (e.g. Zverev [4]). This corresponds to the case iii) of 
how to start FILTERSYN program. In that case a user should write a script containing poles 
and zeros values and call a FILTERSYN program from that script, thus the FILTERPART 
program is not needed. An example of the simple script file called “example4.m” is shown in 
Fig. 35. User had to read the pole zero values from the tables and write them down in one 
m-file (script). Note that the gain K can simply be set to unity, or any other value. That is 
convenient because FILTERSYN has a possibility to calculate the required K value for the 
0 dB filter pass-band gain. 

% These are the comment lines 
% An example of P and Z values from tables 
% for CC 6 25 50 filter 
Z = [i*1.774078; -i*1.774078;... 
     i*1.367782; -i*1.367782]; 
P = [-0.3960663+i*0.3447488;... 
     -0.3960663-i*0.3447488;... 
     -0.0587240+i*1.0187758;... 
     -0.0587240-i*1.0187758;... 
     -0.2151261+i*0.8318082;... 
     -0.2151261-i*0.8318082]; 
K = 1.0; 
% With defined Z, P, K user can start the synthesis 
filtersyn(Z,P,K);  

Fig. 35 Listing of the MATLAB script file for the filter synthesis 
with pole and zero values from filter tables (CC 6 25 50) 

When the program FILTERSYN starts user has to press the “Normalize K” button, the 
program calculates the new gain K value and the new reflection zeros. User can check the 
magnitude of the transfer function as well as the square magnitude of the reflection 
coefficient Rho (Fig. 36). 
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(a) (b) 

Fig. 36 (a) Magnitude of the CC 6 25 50 filter. (c) Square Magnitude of the Reflection Coefficient Rho. 

Note that the maximum magnitude of the transfer function is at 0dB. The gain K and 
zero values are shown in the list-box in Fig. 37(a). User can press Ctrl-A over the list box to 
select all reflection zeros and draw them in the form of pole-zero plot in Fig. 37(b). 

 
(a) 

 
(b) 

Fig. 37 (a) Calculated gain K and Zeros of the Reflection Coefficient Rho. 
(b) Reflection Coefficient Zeros plot. 

Now user can truncate real parts of zeros that are negligible, select 6 Rho zeros and 
present them in the form of pole-zero plot (see Fig. 38). 

 
(a) 

 
(b) 

Fig. 38 (a) Zeros of the Reflection Coefficient Rho without real parts. 
(b) Reflection Coefficient Zeros plot. 

With those data the synthesis of the network’s input immitance can start. Note that in 
this case of the even (6th-) order transfer function we use the impedance function “X1S”, 
which is of the same (6th-) order, as well. We do not use the “X1O” because it is of the lower 
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(5th-) order. The “Invert Immitace” should be switched on because the denominator of “X1S” 
is of larger order than the numerator, thus we proceed with the realization of admittance Y1. 
The remaining steps are the same as in previous example of synthesizing the CC 5 25 49 
filter, and therefore will not be described here again. Finally, the obtained element values are 
presented in “Filter Elements” panel and exported in the workspace as shown in Fig. 39. 

 
Fig. 39 Filter elements in the MATLAB workspace as variables. 

Filter networks that realize calculated filters are shown in Fig. 40. 
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Fig. 40 (a) Doubly terminated LC-ladder realization of CC 6 25 50 filter 

that was originally calculated using FILTERSYN. (b) Dual network. 

If we compare the calculated values to the element values of the same circuit in filter 
tables Zverev we can conclude that our synthesis program has designed the same circuit. In 
Zverev on pages 251-253 there are tables with pole-zeros values and filter element values of 
the CC 6 25 50 filter. The tables are repeated here in Fig. 41. 
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(a) 

  
(b)                                                                                         (c) 
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(d) 

Fig. 41 Tables in Zverev: CC 6 25 50 filter underlined by red line. 
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3.6 “Filter partition” design of a CC 6 25 50 filter 
In this short example we present the design case of the filter network when we start 

with poles and zeros values from filter table (e.g. Zverev). The difference to the example 
above is in that we realize only part of the transfer function; therefore it is the “filter 
partition” design rather than “standard design”. As in the previous example, user writes a 
script containing pole and zero values, and calls a FILTERSYN program from that script. 
Note that some of the poles and zeros that will be realized by a separate biquad are simply 
left out. In our example those are the poles having middle pole Q factor and zeros near the 
cut-off frequency, although other possibilities can be used. An example of the simple script 
file called “example5.m” is shown in Fig. 35. Note that it was readily edited from script 
“example4.m” by simply deleting the lines containing superfluous zeros and poles. The RLC 
ladder network to be synthesised is of the 4th order and has only one zero pair. 

% These are the comment lines 
% An example of partial P and Z values from tables 
% for CC 6 25 50 filter 
Z = [i*1.774078; -i*1.774078]; 
P = [-0.3960663+i*0.3447488;... 
     -0.3960663-i*0.3447488;... 
     -0.0587240+i*1.0187758;... 
     -0.0587240-i*1.0187758]; 
K = 1.0; 
% With defined Z, P, K user can start the synthesis 
filtersyn(Z,P,K);  

Fig. 42 Listing of the MATLAB script file for the filter partition synthesis 
with pole and zero values from filter tables (part of CC 6 25 50) 

The procedure can be accomplished in the same way as above but with one exception: 
real parts of the reflection coefficient zeros cannot be neglected, thus we are not allowed to 
check on the “Truncate Real Parts” check box. Thus there arise an opportunity to choose 
different combinations of the reflection coefficient zeros. This situation will be demonstrated 
in the following example. In the following example we will convey the whole design 
procedure “by partition” on the 7th-order CC filter in more detail. 

3.7 “Filter partition” design of a CC 7 25 50 filter 
We proceed with design of a CC 7 25 50 filter using both FILTERPART program to 

calculate design data and FILTERSYN program to synthesize a network. In this example we 
design a filter network using “filter partition design”, i.e. we calculate elements of ladder LC 
network terminated in resistances in both ends for the part of the CC 7 25 50 filter. Not all 
poles and zeros are selected before the synthesis starts and the obtained network should be of 
the 5th order. For the purpose of this example FILTERPART program looks as in Fig. 43. The 
program calculates Amin = 64.36148 dB; this is the same vale as in Zverev. 
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Fig. 43 FILTERPART program when calculating CC 7 25 50 filter. 

 

All poles and zeros of the CC 7 25 50 filter are shown in Fig. 44(b). To carry on the 
partial design of the filter, user has to simply select those poles and zeros to be realized by a 
ladder LC network, normalize the gain K and then proceed to the filter synthesis. Note that 
user can select many combinations for the filter partition synthesis, and in our example we 
choose poles and zeros as shown in Fig. 44(d). Magnitude, and pole-zero plot of partial poles 
and zeros to be realized by the ladder part of the CC 7 25 50 filter are shown in Fig. 44(a) and 
(c), respectively. Note the new gain K value and the maximum 0dB of the magnitude. The 
user can now press “Filter Synthesis” button, and the FILTERSYN program starts. 
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(a) 

   
(b)                                                  (c) 

 
(d) 

Fig. 44 FILTERPART program: (a) Magnitude of the part of the CC 7 25 50 filter. (b) All poles-and zeros diagram. 
(c) Partial pole-zero diagram. (d) Some poles and zeros selected and appropriate K. 

When user starts synthesis there are all together 10 reflection-coefficient zeros 
available for the user to choose in the program FILTERSYN. All zeros are shown in Fig. 
45(a), whereas the corresponding square magnitude of the reflection coefficient Rho is shown 
in Fig. 45(b). Note that the Rho-squared in Fig. 45(b) is much larger than in Fig. 26(c) of the 
CC 5 25 49 filter, because the network to be realized in this example is the magnitude of 
some general curve, whereas the magnitude curve in example in Fig. 26(c) is of the standard 
elliptic filter type. (Note the difference in scale of the ordinates.) 

(a) (b) 
Fig. 45 FILTERSYN program: (a) Plot of all reflection coefficient Rho zeros. (b) Square magnitude of the Rho. 

User can conclude that the greater sensitivity of the networks magnitude will be 
obtained when the network realizes only a part of the CC transfer function, which is only a 
general curve, than when realizes a whole CC filter. Since user has 5 zeros to choose there 
are four possible ways in that user can do it. The possible combinations are shown in Fig. 46. 
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(a) 
 

(b) 

(c) 
 

(d) 
Fig. 46 Choosing reflection coefficient zeros. (a) All in the left s-plane. (b) All in the right s-plane. 

(c) Alternating in the s-plane. (d) Alternating in the s-plane in the other way. 

To continue with our synthesis we choose the all four cases and program FILTERSYN 
calculate elements that are presented in the Table I. The component values are: 

Table I Element values of the filter design by partition. 

case a) case b) 
R1 = 1.00000000000000 
C1 = 15.86080834376006 
C2 = 2.50828233784809 
L2 = 0.06134165373321 
C3 = 162.61355519756177
C4 = 43.44363724674439 
L4 = 0.00960318862708 
C5 = 93.82783563928089 
R2 = 0.01127497598109 

R1 = 1.00000000000000 
C1 = 1.31574358272734 
C2 = 0.13242795993136 
L2 = 1.16185574944410 
C3 = 1.61720379606577 
C4 = 0.08132225948874 
L4 = 5.13017525275284 
C5 = 0.12921900894860 
R2 = 0.01127497598109 

case c) case d) 
R1 = 1.00000000000000 
C1 = 2.29654052480764 
C2 = 0.06237533876417 
L2 = 2.46671504607182 
C3 = 0.41854058066976 
C4 = 0.01279808877116 
L4 = 32.59841766899359 
C5 = 0.02234015886684 
R2 = 0.01127497598109 

R1 = 1.00000000000000 
C1 = 2.68076928526630 
C2 = 0.40425134724055 
L2 = 0.38061020126138 
C3 = 49.09204270909306 
C4 = 27.17577792174195 
L4 = 0.01535181235027 
C5 = 191.51307781772775 
R2 = 0.01127497598109 

Important note: There exist two solutions for the terminating resistor R2 that satisfy the 
design procedure: those are the first value: R2

I=R2 and the second: R2
II=1/R2. Thus the second 

value user can simply calculate by reciprocating the first R2 value. The one of the values R2 is 
calculated by the program and presented. Which of the two values of R2 should be used is 
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different from the case to case. For example, although the program presents for the four 
design cases a)–d) in the Table I the same value R2=0.011275, the user has to decide himself 
if the value for the terminating resistor is R2 or 1/R2. Thus, in the example above in Table I in 
cases a) and d) there should be R2

I=0.011275, whereas in the cases b) and c) there should be 
R2

II=1/0.011275=88.6918.  

In the case b) we obtain the component values having minimum component spread. So 
we can choose such a combination of the reflection coefficient zeros in the s-plane to realize 
network with minimum component spread as the design criterion. The RLC-ladder network 
that corresponds to the case b) in this example is shown in Fig. 47(a). With this example the 
filter synthesis by partition is concluded. 

In the process of synthesis there exist another one possibility in choosing different 
order of the transfer function zeros realizations, and it can yield another four combinations of 
network element. This case is not presented in this example. Anybody who wishes can 
readily try it by himself, to calculate many different filter networks using this very fast 
synthesis program. Thus, synthesis is really an ambiguous process and our program gives a 
user an opportunity to quickly synthesise high quality filter networks. 

In the “filter partition” design we decompose the filter transfer function T(s) into a 
product of two parts: 

 )()()( sTsTsT BiquadLadder ⋅= . (5) 

Those two parts, that decompose a 7th-order transfer function T(s) can be realized as shown in 
Fig. 47. 
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Fig. 47 7th-order elliptic filter realized by filter partition. 

(a) The realization with elements of ladder RLC directly from the program. (b) The ladder RLC is dual. 

Element values in the Table I case b) are calculated by the program FILTERSYN and 
used for the RLC ladder network in Fig. 47(a). Those values can be used for the dual ladder 
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network in Fig. 47(b), as well, using rules described above, and with the value of terminating 
resistor R2 to be reciprocal to the value of R2 in the original network in Fig. 47(a). Note that 
the resistor R1=1, thus its reciprocal value is again equal to unity. 

A drawback that the passive LC filter designer has to contend with is a given amount of 
signal attenuation in the passband that must be overcome with gain somewhere else. The 
designer of active inductor-simulated filters must accept the same drawback, even though his 
filter structure contains active elements that could, in different circumstances, provide gain. 
Thus, the additional amplifier in Fig. 47 referred to as buffer, provides not only gain but also 
isolation between the cascaded sections, i.e. between 4th-order passive LC filter simulation 
and 2nd-order biquad. The gain of a buffer in Fig. 47(a) is referred to as β1. 

Recall that the relation between the power transmission coefficient t(s) and the voltage 
transfer function T  is given by [1]: )(sLadder

 )(
2
1

)(
)()(

1

2

0

2 st
R
R

sV
sVsTLadder ⋅== , (6) 

where V0 is the voltage of the generator at the input of the ladder LC network and V2 is the 
voltage at the terminating resistor R2. Power transmission coefficient is defined by: 

 
max

22)(
P
Pjt =ω , (7) 

where P2 is the power at the resistor R2, and Pmax the maximum deliverable power to R2. 

When the maximum power is transferred from the generator to R2, there is 1)( 2 =ωjt , thus 

we have  

 
1

2
max 2

1)(
R
RjTLadder =ω . (8) 

To correct the 
max

)( ωjTLadder  to have the value of 1 (or 0dB) we have to introduce additional 

amplification of  

 )1(  with  ;2
1

2
1 ==β R

R
. (9) 

Using (9) the gain β1=0.2123676 for the circuit Fig. 47(a) is defined with the value 
R2=88.6918 in this circuit. For the dual circuit in Fig. 47(b) the gain is designated by β2 
because it differs from the gain β1 in its dual counterpart, only because of the value R2 which 
is reciprocal. Thus the gain β2=18.8353 is readily calculated using (9) with the appropriate 
value of R2=1/88.6918 = 0.011275 of the circuit in Fig. 47(b). 
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The dual passive ladder RLC circuit in Fig. 47(b) can readily be realized using its 
active-RC representation in the form of DCR-circuit in Fig. 49. In DCR circuit every resistor 
corresponds to one inductor in the prototype ladder RLC circuit having the same value, 
capacitors in DCR correspond to resistors in RLC having the reciprocal values, and super-
capacitors (D in DCR) correspond to capacitors in RLC circuit having the same values. DCR 
circuit that simulates the original RLC circuit has the same transfer function magnitude and 
thus the same maximum value. Although due to rules of transformation of RLC to DCR 
circuits, the DCR has the value of C2=88.6918, the gain of the additional amplifier is the 
same as for the original RLC prototype in Fig. 47(b), i.e. β2=18.8353, which provides the 
maximum 0dB magnitude of the T . )(sLadder

The gains of TLadder(s) and TBiquad(s) are designated by kLadder and kBiquad, respectively. 
The overall T  in (5), thus has the gain k= k)(s Ladder×kBiquad. The user can readily read the gain 
k from the Fig. 43, when all zeros and poles for the CC 7 25 50 filter are calculated for the 
first time, as the gain k=0.00448826. When in filter partition design user selected poles and 
zeros to be realized by RLC ladder network, and after the user has normalized its gain to 0dB, 
the gain kLadder readily follows from Fig. 44(d), and has the value kLadder=0.00419649. Finally, 
user can calculate the remaining gain for the Biquad circuit by readily dividing kBiquad= 
k/kLadder= 0.00448826/0.00419649 = 1.06952731295720. Note that the gain kBiquad has been 
calculated with the highest accuracy by the division in the MATLAB workspace. 

3.8 The Biquad circuit realization 
The 2nd-order biquadratic part of the overall transfer function in the case of the elliptic 

filter realization by partition can be realized using well-known Tow-Thomas “Biquad” filter 
circuit with 4 opamps shown in Fig. 48. 

Vout
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R10=R9

C1 C2Vin R4

R7

VLP1
SW1 SW2

R2

VLP2VLP2

VBP

R1 qp=R

R5 qz=R

R8 K=R

R3 ωp=R

R6 ωz=R

 

ωz>ωp

ωz<ωp

Fig. 48 The Biquad filter circuit. 

The transfer function of the “Biquad” circuit in Fig. 48 is given by: 
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The transfer function (10) can be equated to the general form: 
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and we obtain: 
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where ± is + when switch SW1 is closed and SW2 open (as in Fig. 48), – when SW2 is closed 
(and SW1 open). When + the ωz>ωp can be realized, whereas when – the ωz<ωp can be 
realized, whereas when both SW1 and SW2 are open then ωz=ωp. 

The middle term in the numerator in (10) is equal to: 
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Note that if user realizes the finite transfer function zero, as in our example, the middle term 
in the numerator TBiquad(s) has to be zero, thus from (13) we have to calculate R5. 

From the relations describing the circuit in Fig. 48 we can readily see an important 
property of the biquad, i.e. that it can be orthogonally tuned. By this we mean that: 

1. R3 can be adjusted to the specific value of ωp. 
2. R1 can then be adjusted to give the specified value of pole Q, qp without changing 
ωp, which has already been adjusted. 

3. R6 can then be adjusted to give the specified value of ωz, without changing ωp, and 
qp that have already been adjusted. 

4. R5 can then be adjusted to give the specified value of zero Q, qz without changing 
ωp, ωz, and qp that have already been adjusted. (In the case of notch filter the value 
of R5 provides that qz=∞, whereas in the all-pass circuit that there is qz=–qp.) 

5. Finally, R8 can be adjusted to give the desired value of K=kBiquad or pass-band gain 
for the circuit, without affecting ωp, ωz, qp, or qz which have already been set.  

These steps are called tuning algorithm. This algorithm provides for orthogonal tuning, 
which is always preferred over the iterative tuning, especially when the filter is to be 
produced on a production line with a laser used to adjust each circuit element value.  



PART II: FILTER ELEMENTS SYNTHESIS USING FILTERSYN  39 

The step-by-step design procedure for the Biquad part of the filter by partition in Fig. 
47 can be performed as follows: 

1. Choose normalized values R2 = R4= R7= R9= R10= 1, C1 = C2= 1. 
2. Using (12) calculate element values. Calculate R3 = 1/ωp

2, 
3. Calculate R1 = qp/ωp, 
4. Calculate R6 = 1/(ωz

2–ωp
2), because ωp<ωz (the SW1 should be closed). If SW2 

were closed then ωz<ωp and we calculate R6 = 1/(ωp
2–ωz

2), 
5. Set R5 = R1, to have qz=∞, 
6. Calculate R8 = K = kBiquad, to realize gain in the pass-band.  

In our example we choose R2=R4=R7=R9=R10=1, C1=C2=1, and then we can readily 
calculate R3= 2.53, R1=R5=1.7177, R6 = 0.7328, and finally R8=kBiquad=1.06952. Besides the 
tuning feasibility note how the design equations for the 4-opamp Biquad are simple and of 
the explicit form.  

 
Fig. 49 PSpice schematic of CC 7 25 50 filter circuit realized by filter partition. 
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The whole CC 7 25 50 filter realized by filter partition is shown in Fig. 49 in the form 
of the PSpice schematic. Note that the simulated active ladder filter part (DCR filter) is 
cascaded to the biquad circuit part. Finally, the corresponding filter transfer function 
magnitude is shown in Fig. 50. 

 
Fig. 50 Magnitude of the CC 7 25 50 filter circuit realized by filter partition. 

4 CONCLUSION 
A procedure for the design of low-sensitivity and tunable LP active-RC filters with 

finite zeros (of the elliptic type) is presented by partition of filters transfer function. The step-
by-step design procedures are presented in examples for even and odd filter order using 
MATLAB GUI programs FILTERPART and FILTERSYN. In the design we have the 
following steps: (i) calculate transfer function poles and zeros using FILTERPART or read 
poles and zeros from some filter tables (e.g. Zverev); (ii) decompose the transfer function into 
two parts: ladder and biquad; (iii) optimize the gains of the filter transfer function parts to 
have maximum dynamic range; (iv) in the realization of the first part calculate passive RLC 
ladder LP prototype circuit using FILTERSYN. Then use active-RC realization that simulate 
passive RLC ladder prototype; (v) in the realization of the second part use well known design 
procedures of the biquad filter. The biquad filter has the possibility of functional tuning of its 
transfer function parameters. The whole filter designed by filter partition has low-sensitivity 
to component tolerances. Therefore, besides the low sensitivity performance, the newly 
introduced approach provides a good filter solution for manufacturing because it has the 
opportunity of tuning. The filter design method by partition is becoming more and more 
efficient as the filter order is becoming higher. 
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